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Введение
Данное руководство предназначено для ознакомления нового пользователя с основными функциями программы
HOBOware:

• Установка программы HOBOware

• Подключение устройства

• Запуск устройства

• Считывание информации с устройства

• Построение графиков и анализ данных

Onset полагает, что вы проводите пробную установку на диск, чтобы ознакомиться с процедурой перед использованием

регистраторов. Данное руководство предназначено для HOBOware Pro и HOBOware Lite для Windows™ и Macintosh™.

Различия в работе описаны.

Подробную информацию обо всех функциях HOBOware можно получить в интернете или в Руководстве пользователя к
программе HOBOware, которое находится на установочном диске и на сайте Onset: http://www.onsetcomp.com/support/manuals.

Примечания
• В руководстве описана работа с регистраторами HOBO. Если Вы конфигурируете внутреннюю беспроводную систему

HOBOnode, см. соответствующее руководство.

• В данном документе приведены скриншоты английской версии программы.

Обзор программы HOBOware
Программа сочетает быструю, простую загрузку регистратора и считывание данных с серьёзными возможностями
обработки данных.

Интуитивно понятный графический интерфейс позволяет выбрать параметры для отображения, формат графиков, провести
анализ и сохранить проекты для дальнейшего использования.

Программа HOBOware Lite
Программа HOBOware Lite – программа начального уровня для регистраторов данных с  USB-интерфейсом,
обеспечивает простую загрузку, считывание и отображение данных. HOBOware Lite не поддерживает Onset's Data
Assistants и коллекторы данных.

HOBOware Lite поддерживает все регистраторы HOBO серии U (кроме HOBO U30)

Программа HOBOware Pro
Дополнительно к возможностям HOBOware Lite, программа HOBOware Pro предлагает следующее:

• Масштабирование данных, сохранениие графиков для использования в будущем

• Дополнительные инструменты для считывания данных и последующей обработки данных.

• Поддерживаемые устройства

• Регистраторы HOBO серии U
• Метеостанции и микрометеостанции HOBO
• Регистраторы энергетических параметров HOBO Energy Logger
• Коллекторы HOBO U-Shuttle и водоупорные коллекторы HOBO
• Модули HOBO FlexSmart

http://www.onsetcomp.com/support/manuals


4 Getting Started: Using HOBOware with HOBO Data Loggers

Суммарные задачи
Основные шаги по применению регистраторов, пояснённые в данном руководстве. Onset полагает, что вы проводите
пробную установку на диск, чтобы ознакомиться с процедурой перед использованием регистраторов.

1. Установка программы HOBOware
2. Подключение устройств.
3. Запуск регистратора
4. Проверка состояния регистратора
5. Считывание информации с регистратора
6. Построение графиков и анализ данных

Установка программы HOBOWARE

Прежде, чем Вы начнёте
Прочтите файл README на сайте или установочном диске, чтобы получить подробную информацию о системных
требованиях. Если у Вас возникли вопросы, свяжитесь со службой технической поддержки Onset или поселите сайт
http://www.onsetcomp.com/support.

Лицензионный ключ
Когда Вы приобретаете программу HOBOware, в квитанции указывается лицензионный ключ. Если вы приобрели
программу через интернет, лицензионный ключ указывается в онлайн квитанции. После первой установки программы
HOBOware она попросит ввести лицензионный ключ в диалоге License Key Manager. Вы также можете вызвать диалог
License Key Manager, выбрав Help > License Key.

Если Вы используете пробную версию HOBOware, в диалог License Key Manager будет указано, сколько осталось до
окончания пробного периода. По истечении пробного периода от Вас потребуется ввести лицензионный ключ.

Примечание. Если Вы обновляете существующую версию программы, Вам не нужно вводить лицензионный ключ.

Шаги

Windows
1. Вставьте диск с программой в привод компьютера.

Программа установки запустится автоматически. Если установка не началась, дважды нажмите на файл
HOBOware_Setup.exe.

Примечание. HOBOware для Windows требует Java™ 2 Runtime Environment. Если на Вашем компьютере нет Java 2 Runtime
Environment программа HOBOware Setup предложит Вам его установить. (Для установки Java 2 Runtime Environment Вы
должны обладать правами администратора.) Нажмите Yes и следуёте требованиям. После установки Java 2 Runtime
Environment установка HOBOware продолжится.

2. Следуйте требованиям, чтобы установить программу HOBOware.

По завершении установки программа HOBOware запустится автоматически. Если этого не произошло, дважды нажмите
на значок HOBOware на рабочем столе или в меню быстрого запуска. Или в меню Пуск выберите Программы > Onset
Applications > HOBOware.

Macintosh
1. Вставьте диск с программой в привод компьютера.

2. Дважды нажмите на значке CD и дважды нажмите на HOBOware.pkg

3. Когда Вы дойдёте до финального окна установки программы, нажмите Restart.

4. После перезапуска откройте HOBOware, дважды нажав на значок HOBOware.

http://www.onsetcomp.com/support
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Использование помощника настройки HOBOware Setup Assistant (только HOBOware Pro)
Когда Вы в первый раз открываете HOBOware Pro, вас приветствует помощник HOBOware Setup Assistant, который
позволяет Вам изменить основные установки. Для запуска помощника Setup Assistant нажмите Start и следуйте
указаниям.

Примечание. Помощник Setup Assistant – это опция. Если Вы нажмёте Cancel, Вы сможете использовать программу
HOBOware с настройками по умолчанию, перечисленными ниже.

• Типы устройств – по умолчанию это USB

Если Вы включите последовательные устройства (Serial Devices) (только HOBOware Pro) Вы можете выбрать этот
порт для использования.

• Система единиц измерения – по умолчанию это единицы США

• Помощники обработки данных (Data Assistants) – по умолчанию, включены все установленные помощники.

Прочие предустановки
Чтобы посмотреть все предустановки:

Windows: File > Preferences

Macintosh: HOBOware > Preferences

Подключение устройств

Подключение USB устройства
Вы можете подключить большинство устройств к USB порту при помощи входящего в комплект поставки интерфейсного
кабеля.

Примечание - HOBOware Pro: Инструкции по подключению коллекторов и по применению водонепроницаемых
коллекторов в режиме базовой станции см. руководство к коллектору.

Шаги

1. Откройте программу HOBOware

2. Подключите большой разъём USB кабеля к USB порту компьютера.

3. Подключите маленький разъём USB кабеля к USB порту устройства. Если Вы не можете найти порт, см. инструкции к
устройству.

Примечание – только для Windows. Если устройство никогда раньше не подключалось к компьютеру, обнаружение
может занять некоторое время. Появится одно или несколько сообщений, указывающих, что обнаружено новое
устройство. Вы также можете услышать звуковой сигнал.

Примечание – только для Windows. Компьютер может потребовать перезагрузиться. Но в этом нет необходимости.

Когда программа HOBOware опознает устройство, правая сторона диаграммы состояния в нижней части окна программы
обновится и отобразится номер подключенного устройства. С этого момента Вы можете управлять устройством с помощью
программы.

Для отключения устройства просто выньте USB разъём.

Использование базовой станции/соединителя
Некоторым регистраторам для подключения к компьютеру необходима оптическая USB базовая станция/соединитель.
Информация о базовой станции/соединителе указана в руководстве к регистраторам.

Примечание – только для Windows. Если данное устройство никогда ранее не подключалось к компьютеру, обнаружение и
регистрация устройства может занять некоторое время. Появится одно или несколько сообщений, указывающих, что
обнаружено новое устройство. Вы также можете услышать звуковой сигнал.

Примечание – только для Windows. Компьютер может потребовать перезагрузиться. Но в этом нет необходимости.
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Шаги
1. Откройте программу HOBOware

2. Подключите базовую станцию/соединитель к USB порту компьютера.

Важно! Убедитесь, что базовая станция/соединитель подходят к Вашей модели регистратора. Если не уверены, изучите
инструкцию к регистратору.

3. Подключите регистратор к базовой станции/соединителю, как описано в документации к регистратору.

Когда программа HOBOware опознает регистратор, правая сторона диаграммы состояния в нижней части окна программы
обновится и отобразится номер подключенного устройства. С этого момента Вы можете управлять устройством с помощью
программы.

Чтобы отключить регистратор, просто отсоедините его от базовой станции/соединителя. Перед тем, как продолжать,
подождите, пока обновится номер устройства в строке состояния.

Для того, чтобы подключить к базовой станции/соединителю другой регистратор, просто оставьте базовую станцию
подключенной к компьютеру и подключите следующий регистратор.

Чтобы отключить базовую станцию/регистратор, выньте разъём из USB порта.

Подключение устройств при помощи последовательного кабеля (только HOBOware Pro)
1. Откройте программу HOBOware

2. Подключите 9-штырьковый разъём последовательного интерфейсного кабеля к компьютеру или к адаптеру Keyspan™.

3. Подключите другой разъём последовательного кабеля к порту устройства. Если Вы не можете найти порт, см.
инструкции к устройству.

4. Если Вы используете иной порт, чем COM1 (PC) или Default (Macintosh), установите соответствующую настройку в
программе HOBOware. Для изменения последовательного порта:

Windows: File > Preferences > Communications

Macintosh: HOBOware Pro > Preferences > Communications

Обратите внимание, что проверка нескольких последовательных портов может занять некоторое время, даже если ни
одно устройство не подключено.

Панель состояния внизу окна программы HOBOware Pro обноситься, отобразив, что устройство подключено и выбрано.
С этого момента можно начинать использовать устройство.

Примечание. Для отключения устройства просто отключите последовательный кабель.



Getting Started: Using HOBOware with HOBO Data Loggers 7

Запуск регистратора
Для запуска регистратора нажмите на значке «Запуск» на панели инструментов
Отобразится окно запуска регистратора.

Внешний вид окна несколько меняется для разных типов регистраторов, но большинство выглядит так:

1. Description: Введите описание регистратора.

2. Channels to Log: Выберите каналы/датчики, показания которых надо регистрировать.

3. Logging Interval: Установите, с каким интервалом регистратор будет запоминать показания датчиков. В виде
упражнения, установите короткий интервал регистрации (пять секунд или менее), так чтобы Вы могли быстро получать
данные. Когда Вы начнёте действительно использовать регистратор, установите нужный интервал.

4. Sampling Interval - (только Н21 и U30): Установите, насколько часть следует проводить измерения внутри интервала
регистрации. Они будут усредняться и среднее значение будет регистрироваться.

5. Launch Options: Выберите, когда следует запустить регистратор. В виде упражнения, выберите Now (немедленно). Когда
Вы начнёте действительно использовать регистратор, установите нужное время.

6. Utilities - (только для HOBOware Pro):

В зависимости от типа регистратора и датчиков возможны такие утилиты, как «Масштабирование», «Оповещение» и
«Обработчик данных». См. Руководство пользователя к программе HOBOware.

7. Кнопка Launch: Нажмите Launch для запуска устройства.

Программа HOBOware отображает течение загрузки и предупреждает Вас о том, что не следует отключать регистратор, пока
он не сконфигурирован.

Когда загрузка завершена, можно отключить регистратор и начать использование. Для упражнения, оставьте регистратор
подключенным, так что Вы можете ознакомиться со считыванием данных и выводом графиков.
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Проверка состояния регистратора
Для проверки состояния регистратора нажмите на значке «Состояние» на панели инструментов

Появится окно Status, отображающее информацию об устройстве. Наблюдайте за обновлением результатов измерений в
реальном времени.

1. Device Identification: Тип устройства и серийный номер.

2. Current Readings: Показывает результаты измерений для подключенных датчиков, включая последовательный выход с
«Обработчика данных», определённом при предыдущей загрузке.

3. Device Details: Уровень заряда батареи, используемая память, текущее состояние и настройки

Проверка регистратора и датчиков
Чтобы убедиться, что регистратор и датчики работают и записывают данные корректно, проделайте следующие тесты.
Позднее, когда Вы выведите графики, Вы увидите на них результаты тестирования.

Change Current State
1. Если Вы используете регистраторы серии U, оборудованные кнопкой, удерживайте кнопку нажатой в течение
нескольких секунд.

2. Убедитесь, что поле Current States в окне Status изменилось на Button Down.

3. Отпустите кнопку

Изменение показаний датчика
1. Если Вы измеряете температуру, измените показания взяв регистратор (со встроенным датчиком) или датчик в руки

на одну-две минуты.

2. Убедитесь, что показания в окне Status изменяются. ПО завершении проверки закройте окно Status, нажав OK.
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Считывание данных с регистратора
Чтобы получить данные, записанные регистратором, их надо считать.

При считывании данных, они копируются с регистратора на компьютер. Данные можно сохранить в файле и вывести

график. Во время считывания регистратор продолжает записывать данные, если вы его не остановили или память не

заполнилась.

1. Нажмите значок Считать на панели инструментов.

2. Нажмите Stop, когда программа HOBOware спросит, желаете ли Вы остановить регистратор перед выгрузкой данных.

После считывания данных программа HOBOware предложит Вам сохранить данные в файле.

3. Введите имя и расположение файла и нажмите Save. Появится окно настроек графика.

Вывод графиков и анализ данных
После считывания данных с регистратора и сохранения данных в файле появится окно настроек графика. Даже если Вы
просто хотите экспортировать данные в другой формат, сперва следует построить график.

1. Select Series to Plot: Выберите тип данных, которые Вы хотите отобразить и единицы измерения (если возможно)

2. Data Assistant: Обработчик данных программы HOBOware Pro позволяет Вам создать новые даны, сконвертировав
данные, записанные регистратором в другие форматы. Пропустите данный шаг. Более подробную информацию по
обработчику данных см. в Руководстве пользователя к программе HOBOware

3. Кнопка Plot: Нажмите Plot для отображения выбранных данных на графике..
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После нажатия кнопки Plot данные и прочая информация отобразятся на графике.

1. Points Pane: Списки данных в табличном формате.

2. Details Pane: Информация о загрузке и использовании

3. Graph: График данных. Вы сможете видеть изменения в показаниях датчика и изменения состояния, которые Вы
инициировали при тестировании регистратора и датчиков

4. Legend: Отображает ключи для каждого датчика, состояние и серии событий.

Примечание. Чтобы включить Points Pane и Details Pane в программе HOBOware Lite, пройдите: Preferences > Plotting > Points
Table и Details Pane.

Для экспериментов с экспортом, печатью и прочим используйте инструменты из панели инструментов программы
HOBOware. Чтобы получить описание каждого инструмента, остановите стрелку на иконках.

Важно! Перед использованием регистратора измените настройки в окне Launch. См. Руководство

пользователя к программе HOBOware.


